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GIS Facilities at the University of Maryland 
 
McKeldin Library 
 
ArcGIS 10.5, ArcGIS Pro 2.3, and QGIS (an open source GIS software package) are loaded on all 
public workstations in McKeldin Library, including those located in the McKeldin 6101 
instruction laboratory. The laboratory is open to the public during library hours when not in use 
by a class or librarian. The laboratory schedule is posted on the window by the door and 
updated each week. Color printing and large format printing are also available in McKeldin 
Library.  
 
The GIS laboratory is located on the fourth floor of McKeldin Library in room 4120. This 
laboratory is available for use by faculty, staff, and students using geospatial methods in their 
research at the discretion of GIS and Spatial Data Center Staff.  ArcGIS Pro 2.3, ArcGIS 10.5 and 
QGIS are installed on all computers in this laboratory, as well as other geospatial, image 
processing, and statistical packages.  
 
For a complete list of software packages available, please see our GIS Facilities link  
https://www.lib.umd.edu/gis/people-and-facilities 
 
 

Other Facilities 
 
There are other departmental (e.g., anthropology, architecture/urban planning, civil 
engineering, geographical sciences, and landscape architecture) GIS laboratories on campus 
that are restricted to faculty, staff, and students in each of those disciplines. Additionally, the 
Office of Information Technology's software licensing program (​http://www.oit.umd.edu/slic​) 
offers ArcGIS at special/reduced rates for faculty and staff at the University of Maryland. 
  

 

https://www.lib.umd.edu/gis/people-and-facilities
http://www.oit.umd.edu/slic


 

Introduction 
 
A GIS (Geographic Information System) is a powerful tool used for computerized mapping and 
spatial analysis. A GIS provides functionality to capture, store, query, analyze, display, and 
output geographic information.  
 
For this tutorial we will be using ArcGIS Pro 2.3, the newest version of a popular GIS software 
produced by ESRI. This course is meant to teach some fundamental GIS operations using 
ArcGIS. It is not meant to be a comprehensive course in GIS or ArcGIS. However, we hope this 
tutorial will get you started using GIS and excited about learning more. 
 
 
 
 

 
 
 
 

 



 

Components of ArcGIS Pro 2.0 
 
ArcGIS Pro, Catalog, (and Toolbox) 
 
ArcGIS Desktop is comprised of a set of integrated applications, which are accessible from the 
Start menu of your computer: ArcMap and ArcCatalog.  

● ArcGIS Pro​ is the main mapping application which allows you to create maps, query 
attributes, analyze spatial relationships, and layout final projects.  

● The ​Catalog​ organizes spatial data contained on your computer and various other 
locations and allows for you to search, preview, and add data to ArcMap as well as 
manage metadata and set up address locator services (geocoding).  

● The ​Toolbox​ is the third application of ArcGIS Desktop. Although it is not accessible from 
the Start menu, it is easily accessed and used within the desktop software. ArcToolbox 
contains tools for geoprocessing, data conversion, coordinate systems, projections, and 
more. This workbook will focus on ArcGIS Pro.  

 
Software Products (Licensing Levels) 
 
ArcGIS Desktop offers the following three 
types of license: 
 

● Named User (available for ArcGIS 
Pro only) 

● Single Use 
● Concurrent Use 

 
Named User license 
The Named User license type is available 
for ArcGIS Pro only and is the default 
license type for ArcGIS Pro. Using a 
different license type is possible but 
requires a conversion of licenses through 
My Esri. 
 
With the Named User license type, ArcGIS Pro core 
and extension licenses are assigned to members of 
an ArcGIS Online or ArcGIS Enterprise organization. 
Licenses are assigned by the ArcGIS organization 
administrator using the organization's web 
application. 
 
 

 



 

An organization member who has been assigned an ArcGIS Pro license uses their ArcGIS Online 
or ArcGIS Enterprise account credentials to sign in to ArcGIS Pro. The member can sign in to the 
application on any machine on which it is installed (up to three machines at the same time). 
 
The application runs with the license level (Advanced, Standard, or Basic) specified by the 
organization administrator and with any extensions for which licenses have been assigned. The 
license type and level can be seen in ArcGIS Pro on the Licensing page. 
 
 

Single Use license 
A Single Use license authorizes one person to use ArcGIS Desktop, optionally including ArcGIS 
Pro, on one machine, such as a desktop computer. The license also authorizes the same person 
to use ArcGIS Desktop on a second machine, such as a laptop computer. However, the software 
may not be used on both machines at the same time. 
 
A Single Use license can be transferred to a different machine used by a different individual by 
deauthorizing the license on the currently authorized machine and repeating the authorization 
process on the new machine. 
 
It is not necessary to sign in to use ArcGIS Pro with a Single Use license. However, it is necessary 
to sign in with ArcGIS account credentials to access content from ArcGIS Online or ArcGIS 
Enterprise. 
 
Concurrent Use license 
A Concurrent Use license enables multiple users to share access to ArcGIS Desktop, optionally 
including ArcGIS Pro, from any computer on a network or a virtual machine. ArcGIS License 
Manager software, installed on a network computer, manages the distribution of a pool of 
shared licenses. The number of Concurrent Use licenses in the pool determines how many 
people can use the software at the same time. When a user starts ArcGIS Pro with a Concurrent 
Use license, the software sends a request to the license manager to determine if a license is 
available. The user can choose any available license level and extensions. At this point, the 
software is enabled and the number of available licenses decreases by one. When the user 
stops using the software, the license is returned to the pool. 
 
A Concurrent Use license can also be borrowed from the license manager so that the software 
can be used for a specified time while a user is disconnected from the network. When a license 
is borrowed, the number of available licenses in the pool decreases by one. The user can return 
the license to the pool by reconnecting to the network. (The license will be returned 
automatically at the end of the specified borrowing time.) 
 
It is not necessary to sign in to use ArcGIS Pro with a Concurrent Use license. However, it is 
necessary to sign in with ArcGIS account credentials to access content from ArcGIS Online or 
ArcGIS Enterprise. 

 



 

Organization of ArcGIS Pro 
 
ArcGIS Pro can be opened from your Windows Explorer. 

 
Beginning with a Blank Project 
 

1. Search for ArcGIS Pro in your Windows explorer:​    
 
Upon opening ArcGIS Pro you may see the following startup window: 
 

 
 
 
This is a new feature with ArcGIS Pro software that allows you to create projects. Each project 
contains its own geodatabase where you files will be stored.  Since we’re just beginning, we are 
going to create a new project. Click on ​Map.aptx​ to begin. Give your project an name, such as 
“GIS Tutorial” and click ​Okay​. 
 
ArcGIS Pro stores each project in the  C:\Documents\ArcGIS\Projects folder.  If you do not 

specify a location when saving your work, this is the location to which it will be saved. 
 
 
Now you will have a new, blank map document in ArcGIS Pro. 
 

 



 

 
 
 
As you can see, the interface is much different than that of ArcMap and has many different 
components. 
 

 
 
 



 

 

 
 

When you begin, the menu bar changes to show the menu functions available. You can change 
the way the ArcGIS Pro looks by moving or hiding toolbars. Docking toolbars in another location 
can be done by clicking on the vertical gray bar at the left edge or top and dragging it to a new 
location.  
 
Any changes made to the interface will be kept and applied every time you use ArcGIS Pro. 
Please note that some toolbars are dependent upon the license level. Some toolbars and 
extensions will be visible, but the user will not be able to access the functionality if they do not 
possess the required license.  
 

 



 

Adding Data from the ArcGIS Pro Catalog 
 
There are two main ways to add data. We will begin with adding two data files – md_cities.shp 
and mdinterst.shp – from ArcCatalog.  
 

1. Click on the ‘Project’ tab icon at the top right of the display if it is not already open.  You will 
see the new catalog tree. Click the small pushpin in the upper right corner of the Project tab to 
keep it docked and open. 

2. Right click the “Folders” tab, and click “Add Folder Connection”. Navigate to the folder where 
the data you want to add is stored.  For us, that is under Folder Connections 
C:\Users\YOURNAME\Downloads\DATA. Click on the “data” folder and click okay. 

3. We will add two layers:  mdinterst and md_counties.  Expand the Folders tab, and then 
expand the Data folder within it. Drag and drop both layers into the Contents pane. Make sure 
mdinterst is on top for visibility. 

 

 

Adding Data through ArcGIS Pro 
 
In addition to ArcCatalog, it is possible to add data directly through ArcMap.  
 

1. On the Maps Tab, select the ‘Add Data’ button.    If you selected the drop-down, 
choose the first option, Add Data.   

2. Change directories until you find C:\​ ​USERS\”YourDirectoryID”\DOWNLOADS \DATA\  

 



 

3. Select md_cities.shp and click the ‘Add’ button.  
 
On the left-hand side of the view the three selected layers are displayed in the view’s ​table of 
contents​. Each layer has a little check mark in the box to its left.  This means they are “turned 
on” and being displayed.  If you uncheck them, that layer is no longer visible. 
 

 
 
The colors of your layers and their order may differ from the example, but you should have all 
three datasets. Each of these layers contains geometric objects that represent some real world 
entity. Points are used in the md_cities layer to represent Maryland cities. (At a larger scale 
cities could be represented by polygons.) Lines are used in the mdinterst layer to represent the 
interstate highways in Maryland, and polygons are used in the mdcounties layer to represent 
Maryland counties.  
 
Notice how most of the button and toolbar functions are available to us now. Also notice the 

scale display at the bottom of the Map display.  
 
This display tells you what the ​scale value​ is of the current view. If it displays the value ‘1: 
4,790,420’ that means that every one unit on the map is equal to 4,790,420 units in the real 
world. As you zoom in and out of the map the scale will change dynamically. Scale is an 

 



 

important concept in computer mapping. The scale of the map often determines the amount of 
information that can be shown without the map becoming too busy. 
 
Also notice the position display at the bottom of the map display as well. As you move the 
cursor around the view these units change dynamically according to your cursor’s position. Your 

map units are likely in decimal degrees.   

 
 
Moving Around the Map Display  
 
Now let’s examine ways of zooming in and out and panning. The Navigate toolbar contains 
buttons that provide zooming functions and allow you to define a custom view of the layer 
data. Some of the most useful ones are illustrated here.  
 
 

 
 
Zoom In​ – zooms the view window in to a user-defined area. To use: 
 

1. Select the Fixed Zoom In tool  with the left mouse button.​ Clicking this button will 
allow you to zoom in slowly on fixed intervals. 

2. You can also zoom in by holding down the shift key and dragging your mouse to the area you 
would like to zoom in to.  

3. Release the mouse and the view window should zoom in to your defined area and redraw.  
4. You can also use the ball of your mouse to zoom in as well.  

 
 
 
 
Zoom Out​ – zooms the view window out from the point clicked. To use: 
 

1. Select the Fixed Zoom Out tool  with the left mouse button.​ Clicking this button will 
allow you to zoom out slowly on fixed intervals. 

2. You can also use the ball of your mouse to zoom out as well.  
 

 



 

Pan​ – moves all the view layer layers in the direction you move your mouse. It is a useful tool 
when viewing data that is larger than the view window, and you do not want to change your 
scale or loose detail by zooming out. To use: 
 

1. Select the Explore tool with the left mouse button. ​Notice the cursor changes to a hand.  
2. Click a spot on the view with the left mouse button, and while holding down the button move 

the mouse away from the direction you want to move the view and release the button.​ The 
view should move and redraw the view in the new location once the mouse button is 
released. 

 

Full Extent  – zooms the view window to the full extent of all layers shown in the view. 
This is very handy when you want to get back to the way things looked when you first added 
the layer. 
 

Zoom to Previous Extent​  – zooms the view window back to the previous view window 
extent. 
 
Practice using the zooming and panning tools to view the Maryland data. You may also zoom in 
and out by using the wheel on your mouse. You can always return to the initial view by pressing 
the ‘Full Extent’ button; so don’t be afraid to move around!  

 
 
Identifying Objects  
 
Unlike in ArcMap, there is no ​identify tool ​in ArcGIS Pro​.​ Instead, you just need to select  the 
Explore tool, and click on the object you want identified. This helps us to identify the objects of 
a layer. This will display the attributes of a particular layer object. These attributes are actually 
located in a table that we will discuss later.  
 
To identify objects:  
 

1. Make sure the Explore tool is selected.  
 
When you click on a feature in the map, the Identify Results window will open and you can 
choose what layers you would like to be able to identify or see what you have identified. 

 



 

 
 

Setting Map Units, Display Units and Map Projection 
  
One of the very first things that you should do after adding data is to set the map and display 
units. It is also a good idea to set the projection (if desired) at this stage as well. Setting these 
units will allow you to measure distances or compute areas. Display units should also be set if 
you are planning to create a map layout with a distance scale. To set the map and display units: 
 

1. Right click on the ​data frame​ ‘Map’ at the top of the legend and scroll down to ‘Properties.​’  

 

 



 

 
 
The ‘Map Properties’ dialog box pops up. You should be in the ‘General’ tab.  Take a look at the 
‘Display Units’ portion of the dialog box.  As you can see, the map units are already determined 
in this case, but you can choose what units you would like to use for display.  The map units 
here are “decimal degrees” because all of the ESRI data is shipped in decimal degrees. Not all 
data is in decimal degrees. Some data, especially images, are in other map units such as meters.  
 
We will now change our display units to “Miles” by doing the following:  
 
Because our data is in decimal degrees, it is considered unprojected. We want to give our view 
a standard projection. For Maryland, the Maryland State Plane 1983 NAD projection is typically 
used. Let’s set our data frame to this projection.  
 
1. Click on the ‘Coordinate System’ tab. 
 

 

 

 



 

 
Notice that our current coordinate system is a geographic coordinate system (scroll up to see 
that the selected system is in the Geographic Coordinate Systems folder), which is not 
projected.  
 
Let’s select a projected coordinate system. 
 
 
2. Click on the ‘Projected Coordinate Systems’ folder.  
3. Scroll down and click on ‘State Plane’.  
4. Click on ‘NAD 1983 (2011) (US Feet)’.  
5. Scroll down and choose ‘NAD_1983_2011_StatePlane_Maryland_FIPS_1900 (US Feet)’.  
6. Click  ‘OK’.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For more about map projections, consider this website: 
http://egsc.usgs.gov/isb/pubs/MapProjections/projections.html 
 
Or this book: 
Flattening the earth: two thousand years of map projections / John P. Snyder 
University of Chicago Press, 1997 
McKeldin Library – Stacks – GA 110 .S576 1997 
 
 

 

http://egsc.usgs.gov/isb/pubs/MapProjections/projections.html


 

Measuring in the Map Display 
 
Now that we have set the map and display units, let’s make some measurements. 
On the “Inquiry” toolbar there is a button that allows you to measure elements of 
the layers. The ​measure tool​ is the button having the icon of a the ruler.  
  
 

1. Click the measure tool with the left mouse button. ​Your cursor changes to an L-shaped 
ruler with cross hairs and you get a pop-up window.  

2. Move the cursor to the point on the map where you want to start measuring and click.  
3. Now move the cursor to the point where you want to stop measuring and double-click.  

 
Observe in the window the measurement you just made. This measurement is composed of a 
segment length and total length. It also indicates the display units of measurement.  To change 
the units, click on the Options drop-down arrow and click Distance Units 

 
 
You can take measurements that are composed of multiple segments that do not follow a 
straight line. To do so: 
 

1. Click the measure tool with the left mouse button​.  
2. Move the cursor to the point on the map where you want to start measuring and click ​once​.  
3. Now move the cursor to the next point along your defined path and click ​once​.​ ​The first 

segment is defined.  
4. Now move to the second point along your defined path and click once.  

 The second segment is defined.  
5. Repeat this process until you reach the point where you want to stop, and double-click.  

 
Try measuring different parts of Maryland. What is the length of its border along the 
Mason-Dixon line? How wide is the Chesapeake Bay near Baltimore? What is the length from 
the Prince George’s County side of Washington, DC to its opposite end in Montgomery County?  
 

 
 
 
 

 



 

Symbology and Labeling 
 
When a shapefile is opened in ArcGIS, symbols, styles and colors used to display the objects of a 
layer are randomly chosen. This symbology may not be (and usually is not!) the representation 
we wish to use for our map. We can modify the symbology so that our map is more presentable 
and readable. Let’s start by changing the colors of the Maryland cities: 
 

1. Click once, with the left mouse button, the dot below ‘md_cities’ in legend/ table of contents 
to bring up the Symbol Selector.  

 
The “Symbology” tab opens. 
 

 
 
The symbol selector​ ​has several features that allow you to edit each layer symbology regardless 
of type (i.e. point, line and polygon.) You can change the symbol, color, size, and angle as well 
as add more specific symbols to your list.  
 

 



 

Let’s change the styles and colors of our view layers. We’ll begin with cities. 
 

1. Click, with the left mouse button, on the shape ‘Triangle 1.’  
2. On the Properties tab, click on the drop down box for color and choose a dark blue. 
3. Change the size to 10.  
4. Click ‘Apply’.  

 
 
Repeat for the other two layers. 
 

1. Click on the line under ‘mdinterst’ layer name to edit the Maryland interstate layer.  
2. On the Gallery Tab Choose ‘Highway’. ​Because this is already established as an accepted 

style, the color and size of the line will automatically be added.  
3. Click on the polygon under the ‘mdcounties’ layer name to edit the Maryland counties layer.  
4. Select a neutral color like gray or beige under Properties.  
5. Click ‘Apply’ in the “Symbol Selector” window box to apply your changes.  

 
Now we have a much more attractive view. You can experiment with different colors and 
patterns until you find the right ones to suit your final map. 

 
 
Saving ArcGIS Projects 
 
As with most computer projects, it is a good idea to save your work. To do so: 
 

1. Click the Save button on the top left of the screen.  
 
Since you have already created a project and associated .gdb, you do not need to specify where to save 
your project. 
 
 

 
Note that your saved file is an ArcGIS Project File.  This is a GIS-specific file type.  If you try to open this 
document without using ArcGIS Pro software, it won’t work!  
 
 
 
 
 
 
 
 
 

 



 

Labeling: Dynamic labels 
 
There are three types of labels available: ​dynamic​, ​interactive, ​and​ annotation​. Dynamic labels 
are created at once and operate as a group. ArcMap will adjust the label according to the scale 
so that the labels are visible. Although you can set rules for display, ArcMap decides where to 
place them. As a default, labels will not overlap. In addition, you can not individually select or 
change them unless you convert them to annotation. This will be discussed later. 
 
 
Before we label, it’s important to set the rules and choose label position and priorities. Let 
begin with the ‘md_cities’ layer.  
 

1. To turn on labels, select a feature layer in the Contents pane. On the ribbon, under Feature 
Layer, click the Labeling tab, and click Label Enable Labeling. 

 
2. Under the “Label Placement” tab, you can select where you want your labels to be placed. 

The default priority location for labels is in the upper right corner (Basic Point). Let’s 
change the location to the top center (Centered Point). Notice that only some labels are 
visible now. The missing labels can be seen if we zoom in closer to these points.  

 
 
 
 
 
Let’s also label the ‘mdinterst’ as well.  
 

1. Right click on ‘mdinterst’ to open the ‘Context Menu’ again.  
2. Scroll down and click ‘Labeling Properties.’  
3. Make sure to click “Lable” in the Layer tab in order to label all the roads. 

 
Notice that some of the labels for md_cities have moved to make way for the new interstate 
labels.  
 
It is possible to set your labels in a predefined style.  
 

 

 



 

1. Under the ‘Text Symbol’ tab there should be a ‘Label Styles’ box. ​Click on the drop down 
arrow to expand these options 

 
This brings you to the “Label Style Selector” window.  
 

1. Choose the U.S. Interstate HWY symbol (Sheild 1” in 
the bottom right corner and click ‘OK’ and ‘Apply.’  

 
 
 

 
Unfortunately, the labels are too much all together.  
 

1. We can set priority for viewing by right clicking on 
“More” tag located ‘Map’ tab on the Labeling Pane  

2. From the More tag, select “Priorities. 
 
From here it is possible to define the priority of the labels. 
Labels for layers located at the top of the list will be less 
likely to be overlapped by other layers. It, however, is not 
necessary in this case as dynamic labels are not flexible 
enough for our needs. 
 
 
 
 

Performing Analysis in the Map 
Display 
 

 



 

One way to perform analysis in ArcMap is to map certain attributes of layer data. For each 
element or object that composes a single layer there is a set of characteristics or ​attributes 
associated with that object. These attributes, also called ​fields​, are stored in a table that is 
linked to the graphic object. Thus each object in our layer is associated with a record in the 
layer’s ​attribute table​. Let’s view the attribute table​ ​for the mdcounties layer.  
 
To open the attribute table: 
 

1. Right click on ‘mdcounties’ to open the ​Context Menu. ​From the menu, click on ‘Attribute 
Table.’  

 
A table opens at the bottom of the screen showing all the attributes stored with each of the 
Maryland County polygons.  
 

 
 
Let’s just briefly examine the attributes in the layer table window: 
 

2. Move the mouse to the scroll bar at the bottom of the table. Using the left mouse button click 
the scroll arrow to the right to view more attributes.  

 
One of the first fields is “Name” which is the name of the county. Other attributes stored for 
each county include “Area,” “Pop90,” “Males,” Females,” “White,” “Black,” “Married,” 
“Medianrent,” and so on. Much of this data is Census data and includes numerical data that we 
can use in our analysis. Notice at the bottom it says “(0 of 24 Selected).” This refers to the 
records and tells us we have a total of 24 items in our table. There are 23 counties in Maryland 
plus Baltimore City.  
 
 

3.  Double click on  and you’ll see that the Counties will arrange in 
alphabetical order.  

 

 



 

4. Similarly, try double clicking on an attribute with integers (for example area) you will 
see that the counties will arrange in ascending/descending order by area. 

 
 
Notice how the county names will sort themselves according to alphabetical order. When 
ascending, it will sort from A-Z or 0-9, when descending it will sort from Z-A or 9-0. Try it with 
the other columns, preferably those with integers. Quick data organization is beneficial in 
understanding the range of data. 
 
Other options to summarize, calculate values, freeze/unfreeze a column, and delete a field are 
also in this window. 
 
Options for selecting and querying data are also possible from the attribute table. These will be 
discussed later in the workbook. 
 

Click the X next to the mdcounties table label  to exit the attribute table. 

 
Mapping by Category: Unique Values 
 
It is possible to assign different colors according to values in the attribute table.​ ​Let’s make 
every county in Maryland a different color.  
 

1. Hide the ‘md_cities’ and the ‘mdinterst’ layers by unchecking the boxes next to their names.  
2. Right click on ‘mdcounties’ > ‘Symbology.’  
3. Click on the drop down under ‘Symbology’ 

 
4. Then select on ‘Unique values.’  
5. Choose ‘CNTY_FIPS’ in the drop down box under ‘Value Field.’  

 
6. Choose any color scheme in the drop down box in the top right side. 

 
If you want to control the colors assigned to each county, double click on the colored symbol. It 
will allow you to change the color.  
 
8. Close the Symbology Tab.  
 
 



 

Each county will be given a different color. This is useful for distinguishing differences based on 
attributes. 
 
 
 

Mapping by Quantity: Color Maps 
 
Now let’s perform some analysis using a common mapping technique called color or choropleth 
maps. Choropleth maps use color to convey values and are ideal for showing both numerical 
and descriptive text data. We will use the Maryland county layer again for our analysis: 
 

1. Right click on ‘mdcounties’ > ‘Symbology.’  
2. Click on the drop down under ‘Symbology’ 
3. This time, click on ‘Graduated colors’ under the Symbology drop down. 
4. Under the section for ‘Fields’ choose ‘Females’ in the drop down box. 
5. Select “Quantiles” as the Method to use and close the Symbology window. 

 
The map changes to display the counties 
according to the number of females:  
In the example, the lighter colors represent 
counties where the number of females is low 
(relatively speaking) such as western Maryland 
or the Eastern Shore. The darker colors 
represent areas where the female population is 
high – Baltimore City, Montgomery County and 
Prince George’s County. Try this again with 
Pop1990 and see if it the results with females 
are the same as the population in general. 

 
 
 
 
Now let’s reclassify the same data to portray a different view: 
 
The Classification section in the upper left allows you multiple ways to classify the data. You can 
choose the type of classification, number of classes and a rounding value. Let’s try a different 
classification scheme. 
 

1. From the ‘Method’ drop-down box select “Equal Interval” and from the ‘Number of classes’ 
drop-down box select “4.”  

2. Click OK to close the Classification window.  
3. Click ‘OK’ on the Layer Properties window to change the map.  

 

 



 

The view is now changed to display four colors representing the four classes: 
 

 
 
The new classification changes the groupings of our color map resulting in fewer categories and 
differences in which categories the counties fall into. Experiment with the different 
classification systems to see their effect on the data. 
 

 

 
 

Queries 
 

 



 

The real power of GIS lies in the queries that can be performed on the data. Through queries 
we can find precise information quickly. We can also ascertain patterns in the data such as the 
location of customers or low-income residents.  
 

Attribute Queries 
 
There are two main ways to create attribute queries. The first way is through the menu bar.  
 

1. In the Map tab, Click on ‘Select by Attribute’ in the Selection tab.This opens the Select by 
Attributes Geoprocessing tool.  

 
The query window lets you choose which layer you would like to select from and changes the 
list of layer attributes below depending on what you pick in the drop down box. It also contains 
a set of operational tools in the middle left and all the table values for each attribute on the 
middle right. The operational tools including the standard mathematical ones =, >, <, etc. as 
well as the Boolean operators ​and, or​ and ​not​. You build a query by first selecting an attribute 
and then an operation you wish to perform with its values.  
 
Let’s start with a very simple query that locates an object: 
 

2. Change the ‘Layer’ list drop down box to ‘mdcounties.’  
3. Under ‘Method’ choose ‘Create a new selection.’  
4. Click Add Clause 
5. Select ‘Name’, ‘Is Equal to’, and ‘Prince George’s’ in the corresponding query boxes. 

 
Click “Add” 

 
6. Verify that your query looks the same as the example box on the previous page and click 

‘Run.’  
 
 
 
 
 
The boundary of Prince George’s County is highlighted in the aqua. ArcMap always highlights 
selected objects in aqua as a default, which is why it is good to have a gray or darker 
background for queries. 
 

 



 

 

 
Creating a New Map Layer 
 
Now that Prince George’s County has been selected it can be exported from the map and added 
as its own layer. To do this: 
 

1. Right click on ‘mdcounties’ to open the context menu. 
2. Scroll down to ‘Data’ > ‘Export Features’. ​This opens the 

“Copy Features” window.  
3. Within this window make sure ‘mdcounties’ is listed 

under “Input Features” and choose the name and file 
path of your new .  

4. Click “Run’. ​Prince George’s County will appear in the 
map as a new layer.  

5. Check that your file appears in the folder you 
designated.  
 

 



 

 
 

Spatial Queries  
 
We examined simple queries about location and character using attribute data. Now let’s look 
at queries that consider the spatial relationship between objects or layers. This is where the 
true power of a GIS is demonstrated.  
 
Perhaps we want to locate all of the cities within Prince George’s County so that we may export 
them as a new layer file as well. 
 

1. Check the boxes for md_cities and mdinterst under ‘Layers’ to make them active. 
2. From the Map tab select ‘Select by Location’.  

 
The “Select By Location” window opens.  
 
 

3. Select “md_cities” under the ‘Input Feature Layer’ drop down. 
 

4. In the ‘Selecting Features’ drop down box choose your Prince George’s County shapefile 
created in the last exercise.  

 
5. In the ‘Relationship’ drop down box choose “intersect” 

 
6. Leave all other defaults as is.  

 

7. Click the ‘Run’ button.  
 

 

 



 

 

 
 
All of the Maryland cities (in this dataset) that are within Prince George’s County are selected. 
Now try exporting the selected cities as a new map layer. See the previous section for 
instructions.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 
 
Layouts 
 
Layouts are a way of allowing you to make professional quality presentations. You can also 
include tables and charts in a layout as well. To make the transition from view to layout easier, 
you should remember to do a few things while in the Map Display: 
 
● Set the map and display units first. This needs to be done before a scale is placed on the 

layout.  
● Choose appropriate colors for your map. Otherwise you will have to return to your map to 

make changes. 
● Give your view and layers meaningful names. These will be the names the layout uses to 

title your map and label the legend. 
 

1. Clear all of your selected objects.  
2. Make sure that your layers have appropriate colors.  
3. Make sure that the map and display units are set.  
4. Label any features on the map that you want labeled on your layout.  
5. Provide meaningful names to the layers.  

 
 
To do so: 
 

1. Right click on ‘PGCounty’ > ‘Properties’  
2. Click on the ‘General’ tab.  
3. Under ‘Name:’ change it to read “Prince George’s County”  
4. Click OK.  

 

 
 
 



 

Repeat this process with the PG Cities layer.  An alternate method for changing the name of a layer is 
to double click the layer name to automatically be brought to this window.  
 
Now we are ready for layout.  
 

1. In the Insert tab, click on the option for “New Layout”  
2. Select your desired Layout size. 
3. A new, blank Layout view will open. Note that you can easily switch back and forth between 

map and layout views by selecting the desired tab. 

 
4. On the Insert tab, in the Map Frames section, click the Map Frame button. Your map frame should 
now appear in your Layout View. 
 

 
 
From here it is possible to zoom in, zoom out, pan, fixed zoom in , fixed zoom out, zoom to 
whole page, zoom to 100%, go back and forward between extents, and change the percentage 
of your zooming. Practice using these tools. 
 
 

 



 

Adding a Title, Scale Bar, North Arrow, and Legend 
 

 
1. Click on ‘Text’ and a little box will appear on the layout.​ It is possible to change the name 

by clicking on the box and typing in new text. You can also change the size of this box to 
make it an appropriate title size. 

2. Add the North Arrow and Scale bar by clicking on those options from the Map Surrounds tab. 
For each of these you will be given a range of choices.  

3. Pick the one that looks best to you and click ‘OK’​.  
 
You can also add a legend. 
 

1. From the top menu, Legend.  
2. Drag and drop the location that you want the legend to show on the  map. 
3. A ‘Format Legend’ Pane will show up on the left side and allow you to change font size, 

color, and other features. 
 
From here we have most of the elements but they are not in the right place. 

 
Moving Graphics and Layout Objects 
 
To move a graphic object: 
 
1. Select it with the Select Elements tool so that its “handlebars” appear.  
2. The cursor will change to an arrow cross when placed over the graphic. Simply click and drag the 

object to its new location and release the mouse button.​ You can select multiple objects to 
move at once by holding down the shift key when selecting the objects. 

 

Enlarging and Reducing Graphic Object Size 
 
To enlarge or reduce the size of a graphic object: 
 
1. Select the object so that the “handlebars” appear.  
2. Move the cursor so that it is over one of the handlebar squares until it changes to a double arrow.  
3. Click and drag the handle bar square away from the graphic’s center to enlarge. Drag the handle 

bar square into the graphic’s center to reduce.  
4. Release the cursor when the graphic is at the appropriate size.  

 



 

 
 
 
 
Adding Text and More Graphics 
 
Add additional text and graphic objects using the draw toolbar just as you would in the Map 
Display or from the ‘Insert’ menu. Let’s add a text box for source as well as author/date.  
 

1. From the Text tab, click on ‘Text’. In one box type “Source: ESRI Data & Maps 2001”. In the 
other type your name and the date.  

 
 
 

Printing/Exporting the Layout 
 

1. Once your layout is finished you can print it by clicking the Share tab and 
clicking the Print Layout button.  

 
It is also possible to save the layout in a variety of file types.  
 

1. From the Share tab, click the Export Layout tab. 
 
From here you can choose the location to save it, alter the resolution, and select a file type.  

 
 

 



 

More Training and Information 
 
University of Maryland at College Park students, faculty, and staff have access to free online 
courses provided by ESRI. These cover a wide range of GIS topics and skills. To gain access to 
online classes, please contact ​kelleyo@umd.edu​ with the name of the course you are interested 
in and your UMD e-mail address to obtain a registration code. 
 
Course list:  ​https://www.esri.com/training/unlimited-esri-training/ 
 
University of Maryland Libraries’ GIS and Spatial Data Services Center website: 
http://lib.umd.edu/gis/ 
 
University of Maryland Libraries’ GIS and Spatial Data Services Center workshop series:  
https://www.lib.umd.edu/gis/workshops 
 

 

https://www.esri.com/training/unlimited-esri-training/
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